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‘ ois é. Dentre todos 0s artificios de mar-
keting da Apple, parece que um dos pre-
feridos de nosso amigo Steve Jobs ¢ a

polémica. Cada vez ¢ mais frequente nos pegar-

mos discutindo se um novo produto da Apple é

bonito ou nio, esquecendo-nos de prestar

atencao no que mais interessa: o que hd dentro
da maquina.

Mas vamos assumir: todos nds temos um lado

um pouco (as vezes, muito) futil e, assim como

Jobs, sabemos que a aparéncia conta — e muito

— na sociedade pds-moderna.

»

O fato ¢é que o iMac coyla, desde que foi lan-
cado, o produto mais vendido da Apple (ji sio
mais de 5 milhoes!), gracas a inovacao constan-
te. Da metade de 1998 até agora, vimos desfilar
nas “passarelas” de Cupertino iMacs nas cores
Bondi blue, grafite, amora, uva, limao, tangeri-
na, morango, indigo, neve, rubi... Depois de tan-
tas cores, estava na hora de variar um pouco e,
mais do que nunca, fazer do iMac o centro das
atengoes; seja por sua aparéncia, seja pelos
novos recursos. E assim nasceu a nova safra de
iMacs com gravadores de CD-RW, que tem como
membros ilustres os modelos “lisérgicos” Flower
Power e Blue Dalmatian. Sao os primeiros com

textu ez de cores uniformes. Definiti-
vamente, nao conseguem passar desapercebi-

d 0 se estiverem ao lado de Clévis Bornay
ou do Jodo Gordo. Juntos.

Apareneia & tudo

p tud

Se voce estd querendo comprar um iMac novo
mas quer manter sua mesa discreta, nao se
preocupe: ainda existem as cores Indigo e Gra-
phite, que certamente sao duas das mais boni-
tas. Agora, se estiver a fim de arrojar, nio titu-
beie (bela palavra essa, ndo?): € Flower Power
ou Blue Dalmatian na cabeca.

O Flower Power foi assim batizado pela sua
estampa, que evoca os hippies dos idos anos
60-70. Se bem que as cores s30 um pouco
“lavadas” e a frente é totalmente branca. Tanto P>
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melhor, ninguém pode acusé-l

guei”. Sobre o Flower Power h

opiniao: feio, lindo
esqui 0loco

. Ele pas bem a incum-

béncia de ser |

Ja 0 Blue Dalmati ” (al-

guém toma acido ) f

modelo chamado Carmim” va g
resposta), Nao a causar reago

pares, ma ¢ uma unanimidade.

Porém, af ovos padrdes, o iMac con-
tinua tran do — ainda que muito menos que
o habitual — e ainda ¢ possivel ver os compo-
nentes internos da méquina.

Os padroes sio impressos por dentro do plasti-
co do case, com uma reticula de pontos similar
a de uma impressao offset comum. Nada de ou-
tro mundo. Nao se confirmaram os populares
“chutes” de que os padroes revelariam varias
camadas de profundidade, cintilagdes etc. Era
tudo... viagem.

Oueime budo

Chega de futilidades e vamos falar de coisas
importantes. A principal novidade da nova safra

Clock 400 MHz 500 MHz 600 MHz de iMacs, como ji dissemos, € a inclusio do
gravador de CD-RW (com excecio do modelo

P ) I
Cores A mm rm‘m de 400 MHz, que vem apenas com leitor de CD-

ROM). Junte isso ao iTunes e ao Disc Burner e
vocé entenderd porque a Apple baseia sua cam-

Ficha

- - —— e _-—— e am

RAM pré-instalada 64 MB 64 MB 128 MB S A ;
panha publicitiria em torno da capacidade de
Cache L2 512K a 160 MHz 256K a 500 MHz 256K a 600 MHz criar seus préprios CDs. Vocé “ripa” as musicas
Chip de video ATI RAGE Pro ATI RAGE Pro Ultra ATI RAGE Pro Ultra que quiser a partir de CDs ou seleciona arqui-
VRAM 3 B 16 MB 16 MB vos MP3 oAu AIFF e quemTa um disco com uma
bela coletinea usando o iTunes.
Disco rigido 10 GB 20 GB 40 GB
Drive optico CD-ROM CD-RW CD-RW
Portas e conexodes Modem 56K interno, 2 portas USB, 2 portas FireWire,
Ethernet 10/100, suporte a AirPort
Preco R$ 3.290 R$ 3.990 R$ 4.519
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Se vocé tem um gravador de CD, é ébvio que vai
querer fazer uma (s6 uma?) bela coletdnea com suas
misicas favoritas para escutar no carro, tocar numa
festa ou entdo, quem sabe, dar de presente e con-
quistar de vez alguém (acredite, & um presente e
tanto, que pode trazer bons resultados, pois mostra
que vocé é uma pessoa sensivel, criativa, atenciosa
etc.). Com o Toast até da para fazer isso. Porém, se
vocé quiser fazer a coisa bem feita mesmo, o negé-
cio & usar um programa dedicado. Por isso, vamos
mostrar um guia rapido de como fazer um belo tra-
balho com o Jam 2.6, da Roxio, que & um dos pro-
gramas mais indicados para a tarefa. Vamos la:
Junte as msicas que vao entrar em sua coleta-
nea até obter algo em torno de 747 MB, o que
dé 74 minutos. Elas podem estar num CD de audio
ou na forma de arquivos (AIFF, MP3, WAV ou SD2).
Se 0 seu disco for para dar de presente para
alguém, assista ao filme “Alta Fidelidade”, de
Stephen Frears, para saber a maneira certa de sele-
cionar as musicas (este passo é opcional, mas alta-
mente recomendavel).

As misicas que estiverem em CDs de audio
terdo de ser convertidas para arquivos. Para
isso, use o Toast Audio Extractor, que acompanha o

Jam. Insira o CD no drive do Mac e abra o utilita-
rio. O Toast Audio Extractor vai mostrar a lista de

mUsicas (se os nomes estiverem como “Track 17,
“Track 2" etc., duplo-clique na faixa para renomeé-
la). Embaixo da lista, aparece um gréfico de onda
depois de cada mUsica ser extraida.

No menu File » Options, defina o formato como
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ATFF (Wave ou Sound Designer também servem),
16 bits, 44,1 kHz e Stereo. Selecione as faixas do
CD que vao ser “ripadas”, clicando com a tecla
pressionada. Feito isso, clique no botdo Extract e,

Sound Format

Format: | AIFF |
Size:
vade: [Steren ]

[ cancel

] |l ok |

na caixa de didlogo que surgira, defina a pasta onde
0S arquivos serao gravados.
. Junte todos os arquivos que irdo para o CD
numa pasta sé.
Abra o Jam, selecione o menu File » New para
abrir uma sessao e arraste a pasta com os arqui-
vos de audio para a janela do programa. Vocé vera
todas as msicas listadas. Cologue as musicas na
ordem desejada, arrastando cada item.
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Agora é chegada a hora de acertar as diferencas

de volume entre as faixas. Selecione o menu
Edit » Select All (ou pressione @8(A)) para selecio-
nar todas as masicas, e em seguida acione Disc »
Normalize Selection. Na caixa de didlogo que apa-
rece, escolha “Each track individually” e dé OK.
Com isso, 0 programa vai checar o volume que
pode ser acrescentado a cada faixa. Vocé provavel-
mente vera que alguns valores na coluna Gain
(ganho) terdo sido alterados.

Use os botdes de transporte (Play, Stop etc.)

no alto da janela para ouvir as mdsicas e checar

0

! sarado

os volumes. Se vocé achar que alguma misica esta
mais alta do que as outras, clique na coluna Gain e
diminua o volume no bot3o deslizante que aparece.
Nao aumente o volume das outras faixas, porque
elas ja estdo no volume maximo.

Para o seu CD ficar com ar profica, é legal fazer

cross-fades (transicdes) entre as faixas, para
fazer uma faixa emendar na outra (“esquema DJ").
Assim, na coluna Pause coloque o valor de zero
segundo (00:00:00) em todas as faixas, com exce-
¢do da primeira, que necessariamente deve ter um
intervalo de dois segundos (00:02:00). Agora, na
coluna XFade, clique no simbolo parecido com um
“I" mailsculo e selecione a opcdo Set Crossfade. No
campo Length, defina o tempo de cross-fade entre
as faixas. Algo entre 3 e 8 segundos é razoavel,
mas experimente a vontade.

Crossfade

Type

Ce—

Current:

Plazeirnurn: 021232

[ cancel | | 0K J|

No menu pop-up Type, vocé vera varios tipos de
cross-fades. As linhas mostram como vai ser o com-
portamento do volume da faixa que esté saindo e o
da que esta entrando e se a divisdo da faixa sera
antes (Pre-Splice), depois da transicdo (Post-Splice)
ou centrada. Deixe o menu Mode em Overlapping.
Clique em OK e veja como ficou. Se ndo agradar va
mudando o tipo de cross-fade e o tempo da transi-
¢do até encontrar um resultado. Repita o processo
para todas as faixas.

No canto inferior direito, vocé confere o tempo

total de seu CD. Se estiver dando mais do que
74 minutos, tente aumentar o tempo dos cross-
fades ou retire alguma msica da lista, selecionando
o item e clicando no botdo Remove Track.
. Pronto, chegou a hora que queimar o bicho.

clique no botdo Write Disc e, na janela
resultante, selecione a velocidade de 4x, pois essa é
a mais garantida para CDs de audio. Clique em Write
Disc de novo e espere o disco sair do forno.
. Coloque o seu novo disco num CD player e
escute a gosto.




P> Apple pelo menos poderia
mais veloz no modelo topo de
Os novos iMacs passam a vir o

um bom poder

“primo pobre”,

traz a versao com 8 MB. Os
sadores de 600 MHz comp
vagoes e sao a melhor ped

MHz de clock, MB de dis
Todos os iMacs incluem
FireWire, modem 56K in
10/100. Assim, qualquer

esta capacitada para capturar
FireWire e editar filmes com oi
vem incluido). Tod ¢
iTunes, Disc Burr

e Cro-Mag Rall

Ja estava na b

como

Otimo: vocé comprou um gravador. Agora, vocé
ndo tem mais desculpa para deixar de fazer aque-
les becapes tdo importantes, de que sempre fala-
mos e vocé finge que ndo escuta. Afinal, CD-Rs
sao baratos demais para serem ignorados. E chega-
da a hora de vocé sacar seu Toast e preservar os
arquivos mais importantes.
Veja agora como fazer um bom becape, passo a
passo, na versao 4.1 do Toast:

Rode o Toast e selecione o menu Utilities »

Create Temporary Partition. Na janela que se
abre, defina 0 nome (Name) da particdo, que vai
ser 0 mesmo nome do CD (ex: “Meu Becape”).
Em Size (tamanho), defina 650 MB. Se vocé
tiver mais de um HD, escolha em qual seré criada
a particao no menu On. O Toast criarad uma ima-
gem do CD usando o espaco livre de seu disco.
Esse método é mais complicado do que simples-
mente arrastar os arquivos para a lista de conted-
do, mas é mais seguro.

Fazen !g!g

Create Temporary Partition

Name: [Meu becape] |

Size: MB
oOn: [ Nigro (441 MB free) %]
[ Cancel ] || 0K I

A imagem “Meu Becape” aparecera no desk-

top. Vocé vera que o icone é horroroso, mas
sinta-se a vontade para mudé-lo no Get Info.
Arraste todos os arquivos que vdo entrar no CD
para o disco virtual. Organize a disposicdo dos
icones do modo que preferir, para que o CD final
fique com o mesmo aspecto.

Arraste “Meu Becape” para cima do Toast. Se

vocé quiser que o CD abra automaticamente
quando for inserido no drive do Mac, dé dois cli-
ques no disco virtual para abrir a janela, posicio-
ne-a no canto superior esquerdo do desktop e sb
entdo arraste o disco virtual para o programa.
0 Toast vai mudar para a op¢ao Mac Volume.
Clique no botdo Data e, na janela que se abre,
vocé vera duas opgdes para serem escolhidas:
Optimize On The Fly for Speed (“otimizar no ato
para maior velocidade™) ou Optimize On The Fly
for Size (“otimizar no ato para tamanho)”. Esta
(ltima é a ideal se houver muitos arquivos para se-
rem gravados. Se vocé quiser criar um disco “boo-
tével” (de startup) para o Mac, acione a opcdo
Make This Disk Bootable. Porém, vocé terd que ins-

el

sem erro

talar no disco virtual um Core System Folder (siste-
ma operacional basico) a partir de um instalador do
Mac 0S, escolhendo a opcdo Custom Install. Assim,
vocé pode criar um disco de emergéncia que con-
tenha esse Mac OS e um programa reparador de
discos, como o Norton Utilities, por exemplo.

Select Volume

Yolume Size Comment
FMacintosh HE S080.2 MEB ok to write

untitled 2 20806 ME ok to write

[ Optimize on-the-fly |for Speed %

[ Don't copy free space

[ Bootable
OAutoStart: [ ]
[ Info... ] [ Cancel ]|| 0K I

Acertados todos os detalhes, clique no botdo
Write CD na janela principal do Toast.

———=p

TOA ST ¢
8 SO0 O

Adaptec Toast™

|

0 Files & Folders £
$25.6 MBCD-ROM
' ! 34Files / 0 Folders
U Total: 02:58:44
u CD Recorder
U Mitsumi CR-4804TE
USE #0

[_CheckSpeed.. | [ write D.. |

Na caixa de didlogo que surge, vocé define a velo-
cidade (Speed) de gravacdo e tem a opgdo
Simulation Mode, que simula a gravacdo do CD
para vocé saber se tudo correrd bem. Assim, se
ocorrer algum problema, vocé ndo perdera a midia.

Start writipono

age First

[__write session__|

[ Cancel ] [ Write Disc ]

E hora de gravar. Se vocé quiser gravar uma

sessdo (caso tenha sobrado espago no CD), cli-
que em Write Session ou escolha Write Disc se
quiser “fechar” o disco.

Agora, é s6 esperar 0 CD acabar de ser quei-

mado para vocé ter seus dados becapeados.



)enas uma questao
a proxima leva.

0 novo e o velho

Aos americanos, o novo. Para o resto do
mundo, o velho. A Apple nio fala sobre o
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Faca seu

proprio cd

de qualidade
comencial com uma

Por mais que vocé capriche na hora de gravar um
(D, nenhum trabalho ficara realmente profica sem
um rétulo impresso e uma capinha. Se vocé tiver a
impressora certa @ mao, seu disco vai ficar pratica-
mente com a mesma cara de um industrializado.

E claro que vocé pode passar em uma boa papelaria
e comprar etiquetas colantes para CDs e imprimir
rotulos em qualquer impressora. Fica bom, mas ndo
tem charme. Existe uma alternativa mais profissio-
nal: a CD-Printer. Distribuida no Brasil pela Grava-
dor.com, essa impressora permite criar CDs com
apresentacdo impecavel. E o melhor é que vocé vai
poder dizer “fui eu que fiz", sob olhares invejosos.
A CD-Printer é basicamente uma impressora jato de
tinta colorida Epson Stylus Color, modificada - ao
que parece, na Franca ou Canada, ja que os manuais
e o0 software para Mac (Adobe PhotoDeluxe) que
acompanham o produto estdo todos na lingua de
amour. Para ndo ser injusto, o produto inclui um
pequeno manual com as instruces em portugués e
um CD (de PC) com templates (modelos) de
impressao para QuarkXPress e CoreDRAW.

0 francés pode até

Por isso, baixei do site da Epson o driver em inglés
para poder operar a impressora mais tranquilamente.
Como a Stylus Color 760, a CD-Printer tem porta
USB e imprime com resolucdo de 720 x 720 dpi.

A principal diferenca entre a CD-Printer e o modelo
original da Epson &, claro, a capacidade de imprimir
rotulos de CD, o que é feito a partir de uma bande-
ja especial localizada na parte traseira do equipa-
mento. Ha também uma “férma” para colocar o CD
a ser impresso.

Templates

Se vocé nao tiver o QuarkXPress ou CoreDRAW
para abrir os templates, sera necessario criar seu
proprio modelo, no programa que achar melhor. Eu,
por exemplo, fiz um no Illustrator, na tentativa e
erro (imprimindo circulos coloridos até conseguir
obter um alinhamento perfeito). Demorou um
pouco, mas ficou 6timo.

0 Gnico problema é que, de um dia para outro, a
impressora pode resolver que o template ndo vale
mais e imprimir tudo errado. Por duas vezes, tive

ser a lingua do amor, O SO 90 P 30 O AR 191

__..;;_mmu.mmm ) E— =

mas definitivamente

Tiri)

nao é o meu idioma
preferido quando se
trata de Macintosh.
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incriminatorias. Outra descoberta infeliz é que,
as vezes, gotas de tinta podem cair na forma do
CD e eventualmente criar alguns pequenos bor-
roes na superficie. Nada muito grotesco, mas
mesmo assim nao é muito legal.

A CD-Printer também é uma 6tima alternativa
para imprimir em papel, ndo sé em CDs.
Utilizando papéis especiais para impressdo, &
possivel fazer capas, contracapas e livretos (vem
um kit da Epson com varios tipos de papéis),
com 6tima qualidade. O produto utiliza dois car-
tuchos (um preto e outro colorido) para a im-
pressdo a quatro cores, e ainda conta com um

que refazer o modelo, sem entender por qué. ca na area do rétulo. Existem algumas marcas que 6timo painel de controle para facilitar o proces-
Na hora de imprimir o primeiro CD, vocé fica meio oferecem essas opgdes. Testamos alguns CDs so. E a CD-Printer trabalha bem silenciosamente,
tenso, mas o resultado é de 6tima qualidade. “imprimiveis” da Philips, que sdo 6timos para gravar se a compararmos com alguns modelos da Epson.
Espere alguns minutos para a tinta secar e estara dados, mas algumas das impressdes borraram com o - - - -

tudo lindo. tempo. 0 negdcio é testar varias marcas. DIﬂhEIf‘D, dlnhEIf‘D

A CD-Printer ndo imprime em qualquer CDR ou CD-  Depois de imprimir alguns CDs, descobri que é bom 0 principal problema da CD-Printer é o preco,
RW. A midia tem que ser “printable”, ou seja, feita  dar uma boa limpada na superficie antes de qualquer bem acima das impressoras convencionais: R$
para impressdo, com superficie completamente bran-  coisa, se vocé ndo quiser ver impressoes digitais 1.900. salgado, mas pode ser um bom investi-

mento para profissionais e empresas que queiram
melhorar a apresentacdo de seus CDs. O resulta-
do é garantido. O outro inconveniente é que,
depois de usar essa impressora, vocé nunca mais
vai querer usar uma caneta para escrever no
rotulo de algum disco...

Preco: R$ 1.900
Onde comprar: Gravador
whw'w JEavadar . com.br
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transForme seu velho Ip em um
cd novinho

0 long-play, também conhecido como LP - ou
“bolacha” para os intimos -, ndo foi forte o sufi-
ciente para resistir a chegada do CD na década de
80. Aos poucos, a maioria dos titulos que existia
em discos de vinil foi sendo lancada no formato
digital para que pudéssemos esquecer de vez nos-
sos (cada dia mais) velhos LPs. Claro que, fora os
DJs (que usam o vinil profissionalmente até hoje),
ainda ha quem mantenha o habito de ligar o toca-
discos da sala, por saudosismo ou pela convic¢do
de que as “bolachas” sdo imbativeis, mas sdo casos
raros. A verdade é que a esmagadora maioria esta
com o CD e ndo abre.

Mas o triunfo do Compact Disc s ndo foi total
porque existem muitas obras que ndo foram - e
talvez nunca sejam - relangadas em CD. O resulta-
do é que, as vezes, nos deparamos com aquele LP
na prateleira que tanto queremos ver digitalizado,
remasterizado e reembalado, mas ndo da para con-
tar com a colaboracdo das gravadoras. O jeito,
entdo, é fazermos nds mesmos o servico, enquanto
nossos pickups ainda funcionam.

Recuperar completamente um disco de vinil surra-
do ndo é uma tarefa simples e exige programas e
equipamentos que fogem da realidade financeira
da maioria dos mortais. Mas é possivel dar um
trato basico no som de LPs com o auxlio de pro-
gramas como o Spin Doctor, que é instalado jun-
tamente com o Toast Deluxe (versdo comercial),
da Roxio. Esse software permite que vocé grave
sons diretamente para ele e aplique filtros para
eliminar ruidos e ajustar o volume do audio, para
depois queimar um CD. A seguir, veremos como
fazer isso em detalhes.

Faga o som chegar

Porém, antes de fugar no Spin Doctor, vocé vai
precisar providenciar um modo de o som de seu
toca-discos chegar até o Mac, pois é preciso ampli-
fica-lo primeiro. Para isso, a maneira mais facil é
usar um equipamento de som que permita conectar
0 toca-discos - pré-amplificador ou receiver. Se

'~ & [T Edit inputs

ele ja estiver embutido num minisystem, tudo fica
mais facil. O jeito mais prético é ligar a saida de
fone de ouvido do aparelho de som na entrada de
audio do computador. O tipo de cabo necessario
para tal operacdo pode variar de caso para caso.

A maioria dos Macs usa entrada de éudio P2 (plug
miniatura estéreo), que é a mesma usada para
conectar um microfone externo. Porém, o Cubo, o
Book e o PowerBook G4 nao trazem nenhuma
entrada de som, de modo que essa operagdo s6 &
possivel com o auxilio de algum modulo de conver-
sao USB ou FireWire que tenha entrada de audio.
Infelizmente, nenhum desses aparelhos é vendido
por aqui. A melhor pedida, ao que parece, é o
iMic, da Griffin (http://wwwgrif fintechnology.
com/audiod imic_main htm).

0s modelos de Mac da série AV (7300, 7600,
8500, 8600, 9600, entre outros) trazem conec-
tores de dudio tipo RCA (um encaixe vermelho
para o canal direito e um branco para o esquerdo),
0 mesmo usado em aparelhos de som para conectar
dispositivos externos. Se for o caso de sua
maquina, dé preferéncia ao RCA, pois a qualidade &
melhor; se seu som tiver alguma saida desse tipo,
use-a. Agora, tudo o que vocé precisa fazer é arru-
mar um cabo que seja adequado a situacdo.

Nivel de gravagao

Resolvido o problema do cabo, abra o Spin Doctor.
Se vocé estiver usando memoria virtual, ele ndo
vai rodar; abra o painel de controle Memory (Me-
moria), desligue essa op¢do e reinicie seu Mac.

0 Spin Doctor devera criar uma nova sessdo de
gravacdo. Se ndo, va ao menu File » New Record.
Para definir a fonte sonora da gravacdo, selecione
Inputs » Sound

New Record BN In. Coloque o LP
Open... 20 para rolar e veja
Save %8s se as luzinhas
Save As.. (LEDS) do progra-
saveTo.. ma esto acen-

2 [TE o dendo; caso con-

ey

trario, verifique ' Eagit Tracks Help

se os cabos estdo
bem conectados.
Se tudo estiver
certo, requle o
volume de saida do aparelho de som até ver os LEDs
ficarem amarelos. Esse ajuste também pode ser fei-
to usando o botdo VU do programa (o terceiro de
cima para baixo a direita), que altera o ganho da
entrada de dudio.

Se os LEDs atingirem o pico e ficarem vermelhos,
diminua o volume, pois isso quer dizer que ele esta
alto demais e causara uma distorcao ruidosa na
gravacdo digital. De preferéncia, faca um teste com
uma das mdsicas mais “agitadas” do LP, ou seja,
com maior intensidade sonora, para evitar mas sur-
presas durante a gravacao.

Vinil girando

Bem, chegou a hora de botar para gravar. Antes,
verifique se vocé tem espaco em disco para a gra-
vacao; um LP inteiro vai ocupar algo entre 400 e
600 MB. Tudo OK? Entdo clique no botdo REC (com
um circulo vermelho) e deixe o som do vinil rolar. O
Spin Doctor s6 faz uma gravacdo por sessdo, de
modo que, se vocé estiver passando um LP inteiro
para o HD, grave cada lado do disco de uma sb vez.
Quando quiser parar de gravar, clique no botdo Stop

External Mic

Internal Modem
None
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(0 que tem um quadrado desenhado). Depois de
realizar a gravacdo, o Spin Doctor pedira para vocé
nomear o arquivo AIFF com tudo o que foi digitaliza-
do, salvando um arquivo (nico que ficara na pasta do
programa. Feito isso, salve a sessdo. Repita o proces-
so para o outro lado do LP, se necessario.

Criando as Faikas

Na parte inferior da janela do Spin Doctor, é possivel
ver o formato das ondas do som gravado. Isso é
importante para vocé poder selecionar os trechos que
vao virar as faixas de seu CD. Assim, se vocé gravou
um LP inteiro (ou parte dele), poderd selecionar o tre-
cho correspondente a primeira mdsica clicando sobre
0 comego do trecho desejado e arrastando o mouse
até o ponto final. Para selecionar com mais precisdo,
utilize os botdes de zoom (com as montanhas), ao
lado da barra de rolagem.

Clique no botdo Play para verificar se a selecdo esta
bem feita. Depois, va ao menu Tracks e selecione
Define Track (#8D)). Ao fazer isso, uma nova faixa
sera adicionada a lista do Spin Doctor.

Inputs Help
Auto-Define Tracks 3T |

Define Track

Delete Track

Repita o processo com todos os trechos que desejar.
Duplo-clicando uma faixa, é possivel renomeé-la. Se
quiser deletar alguma, selecione-a e dé (Delete).

Limpeza geral

E chegada a hora de dar aquele trato no som.
Selecione uma das faixas e clique no quarto botdo a
direita (contando de cima para baixo); vocé veré a
janela de filtros, que contém as seguintes opgdes:
=Noise and Pop - Esses sdo os filtros mais impor-
tantes na hora de tentar tirar ruidos e “pocs” de
LPs, mas também sdo os que mais exigem processa-
mento (se sua maquina for muito lerda, talvez eles
ndo rodem direito). Habilite essa op¢do e bote uma
faixa para rolar. Mexa nos controles Noise, para di-
minuir o chiado, e o Pop, para remover os “pocs”.
Vocé vai reparar que, quanto mais arrastar o botao
para a direita, mais ele terd efeito. Porém, notara
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também que, a partir de um determinado ponto, o
audio comega a ficar comprometido. Assim, procure
um meio-termo.

= Realizer - Esse filtro ajuda a dar uma “garibada”
geral na equalizagdo, mas se ndo for usado com come-
dimento pode trazer mais maleficios do que benefi-
cios. 0 botdo Bass serve para controlar as frequéncias
baixas (graves), que podem sumir quando se usa os
filtros de Noise e Pop, ou entdo aparecer em excesso
em discos muito “rodados”. O Exciter trabalha as fre-
quéncias mais altas (agudos), que costumam desa-
parecer do vinil com o uso ao longo dos anos. E o
Width mexe na imagem estéreo, podendo dar mais
“ar” a masica (& dificil explicar so com palavras). Nao
exagere na dose desse (litimo controle em especial.
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= Qutput Level - Depois de mexer nos filtros acima
é possivel que haja alteracdo de volume do arquivo de
audio para cima - o que pode gerar distor¢des - ou
para baixo (compare o som com e sem os filtros para
ouvir a diferenca). Assim, use esse recurso para com-
pensar as mudancas.

Depois de chegar a um resultado satisfatério, clique no
bot3o Apply para aplicar as alteragdes, mas lembre-se
de que ndo havera reversdo no processo. Escute o re-
sultado para ver se esté “oquei”. Vocé podera aplicar a
mesma configuracdo de filtros para as outras faixas, ou
editar pardmetros diferentes para cada uma delas, pois
ha diferencas sonoras entre cada misica de um LP -
em geral, mdsicas proximas a beirada externa tém mais
“clics” e “pocs” e as mais internas, equalizagdo pior.

No Forno

Depois de tudo limpo, vocé sb precisa selecionar as
faixas que vao entrar no CDs da lista do Spin Doctor
(para selecionar mais de uma, clique segurando a tecla
(Shift). Feito isso, clique no botdo com icone de um
CD (o primeiro a direita) e o Toast vai criar uma
sessdo de udio com todas as faixas selecionadas. Se
quiser, vocé pode fazer novas gravagdes e edigdes no
Spin Doctor e adicionar novas faixas a sessao criada
no Toast, até completar os 74 minutos do CD. Depois,
é s6 colocar um CD-R no gravador e mandar queimar.
Agora sim, ja da para aposentar de vez aquela sua
velha “bolacha”. IV}
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512 KB, fora do chip, e rodai
locidade do processador, ou
Hz) estd sendo vendido ao
do modelo com 'uip novo. E
questio do proce r. Os model
nacionais” de 500 também ter
sos de placa-mae i aos dos iMa
lancados no ano 0 — incluindc
RAGE 128 Pro e MB de SDRA
Mas isso ndo € motivo para se sentir i
do. O novo chip PowerPC 750CX € s6 5%
mais ripido do que o anterior.

Admiravel iMae noveo

Polémicas a parte, ¢ admirdvel como a Apple
consegue manter a vivacidade dos iMacs apos

quase trés anos. E ji
que a aparéncia co
droes coloridos sa
mesmo que voce n
ha as cores Indigo A
Steve Jobs acabou de abrir um grande leque
de possibilidades para o futuro. Alguns ca-
minhos podem ser tenebrosos (ja pensou em
um iMac da Barbie?). Por outro lado, seria
fascinante se fossem lancados os modelos
com padroes Van Gogh, Picasso ou Mir. E,
indo mais longe, j4 imaginou um iMac cu-
bista? O dificil seria encontrar o gravador de
CD, mas isso seria apenas um detalhe. IV}




